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Exam A 

QUESTION 1 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 
1. Project file 
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2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

 To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

 To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

 To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 

 To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands:  Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

 Restart Project. Closes and reopens the current project file without saving your changes. 

 Submit Project. Saves your changes, submits the project file, and moves to the next project. 

 Calculator. A calculator is available in some exams. You are not required to use the calculator. 

 Restore. Restores the size and position of the project file and exam panel to the defaults.  Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

 Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

 Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

 Mark for review. Flags the task to indicate that you want to return to it before you finish the exam.  Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

You are analyzing data about the number of visitors to U.S. National Parks. 

Configure Excel so that you can edit content using Albanian as the editing language. 

Do not make Albanian the default editing language. If you are prompted to restart Office, dismiss the prompt but do not restart Excel. 

1 (exhibit): 

2 (exhibit): 

3 (exhibit): 

4 (exhibit): 

5 (exhibit): 

6 (exhibit): 

7 (exhibit): 

8 (exhibit): 

9 (exhibit): 

Correct Answer: See explanation below. 
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Section: National Parks 

Explanation 

Explanation/Reference: 

Explanation: 

1. In the open document, click on File. 

2. Click on Options. 

3. Click on Language. 

4. Under the Choose Editing Languages section, use the drop-down menu to select a new language for Office to use to check spelling and grammar. 

5. Click the Add button. 

6. Click the OK button. 

7. Click the OK button again. 

Reference: https://www.windowscentral.com/how-change-proofing-language-settings-
office 

QUESTION 2 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks.  
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 
 To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

 To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

 To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
 To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands:  Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

 Restart Project. Closes and reopens the current project file without saving your changes. 

 Submit Project. Saves your changes, submits the project file, and moves to the next project. 

 Calculator. A calculator is available in some exams. You are not required to use the calculator. 

 Restore. Restores the size and position of the project file and exam panel to the defaults.  Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 
- Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

- Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

- Mark for review. Flags the task to indicate that you want to return to it before you finish the exam.  - Mark as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “2019 Visitors” worksheet, modify the conditional formatting rule to format rows for parks that have a “Size” greater than 1,000 square miles. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Exhibit 7 (exhibit): 

Exhibit 8 (exhibit): 

Exhibit 9 (exhibit): 

Correct Answer: See explanation below. 

Section: National Parks 

Explanation 

Explanation/Reference: 

Explanation: 

1. Select the entire dataset. 

2. Go to Home –> Conditional Formatting –> Highlighting Cell Rules –> Greater Than.. / Less Than.. 

3. Select the ‘Greater than’ option. In the dialogue box, enter the number in the field on the left. The intent is to highlight cells that have a number greater than this specified number. 

4. Specify the format to be applied to the cells that meet the condition by using the drop-down on the right, or specify your own format using the Custom Format option. 

5. Click OK. 

Reference: 
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https://trumpexcel.com/excel-conditional-formatting/ 

QUESTION 3 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 
1. Project file 

2. Split bar 
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3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 
 To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

 To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

 To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 

 To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands:  Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

 Restart Project. Closes and reopens the current project file without saving your changes. 

 Submit Project. Saves your changes, submits the project file, and moves to the next project. 

 Calculator. A calculator is available in some exams. You are not required to use the calculator. 

 Restore. Restores the size and position of the project file and exam panel to the defaults.  Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

 Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

 Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

 Mark for review. Flags the task to indicate that you want to return to it before you finish the exam.  Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Summary” worksheet, starting in cell A4, consolidate data from the 2014-2018 “by Region” worksheets. Display the average number of the “Recreation Visits” for each “Region”. Use labels in both the top row and left column. 

Delete the blank “Park Name” column from the consolidated data. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Exhibit 7 (exhibit): 

Exhibit 8 (exhibit): 

Exhibit 9 (exhibit): 

Correct Answer: See explanation below. 
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Section: National Parks 

Explanation 

Explanation/Reference: 

Explanation: 

1. Open the worksheets you want to consolidate. 

2. Ensure the data in each spreadsheet is listed in a consistent format. Make sure the labels on each spreadsheet are listed in a consistent format. For example, if you have the date listed in the top row, and the product listed in the leftcolumn, 

make sure this is the same format for each spreadsheet. Make sure the rows and columns are in the same location for each spreadsheet. Delete any blank rows or columns in the spreadsheets. 

3. Open a the “Summary” worksheet. 

4. Click the cell that you want the consolidated rows and/or columns to start. Click the row and/or column that is consistent with where the tables are located in the other spreadsheets. 

5. Click Data. It's in the menu bar at the top of Excel. This displays the Data panel at the top of the page. 

6. Click the Consolidate icon. It's the icon that resembles two sheets with a blue arrow in between them pointing to a blue third sheet. This opens the consolidate menu. 

7. Select a function. Use the drop-down menu below "Function" to select the method that the data will be consolidated. For example, if you want to add all the data together, select Sum. You can also select Count, Average, Min, Max andother 

functions. 

8. Select a reference source. This is the first spreadsheet that you want to consolidate. If you want to consolidate sheets within the same file, click the arrow icon to the right of the bar below "References". 

9. Highlight the data you want to consolidate. If you are consolidating data from a separate sheet within the same file, click and drag to highlight data and labels you want to consolidate. This will display sheet name followed by anexclamation 
mark followed by the row and column range in the references column (For example: "Q1SalesSheet!$A$2:$F$5"). 

10. Click Add. It's to the right of the "All References" list box. This adds the reference and range you select to the list of references. Repeat steps 6 through 10 for all sheets and files you want to consolidate. 

11. Select the row or column for the labels. Click one or both checkboxes next to "Top row" and/or "Left column" to select which row or column contains the labels. 

12. Click the checkbox next to "Create links to sources" (optional). By checking this option, the consolidated data will be updated automatically if one of the source references is updated 

13. Click Ok. This adds the consolidated data to the “Summary” worksheet. You can see the source data from the consolidated data by clicking the plus icons (+) to the left of the cell numbers on the left side. 

1. With your spreadsheet open, press F5 on the keyboard. The ‘Go To’ window will open. 2. 
Click on the ‘Special’ button 

 

3. Click on ‘Blanks’ then click ‘OK’ 
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4. This will select all the empty fields within your table. 

 

5. In the ‘Home’ ribbon, click on the arrow below the ‘Delete’ button then click on ‘Delete Sheet Columns’ 
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6. Your empty columns have now been removed. 

Reference: https://www.wikihow.com/Consolidate-in-Excel#/Image:Consolidate-in-Excel-Step-5-Version-

4.jpg https://www.itsupportguides.com/knowledge-base/office-2016/excel-2016-how-to-delete-all-empty-

columns/ 

QUESTION 4 
Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 
 To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

 To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

 To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 

 To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: 

 Collapse Panel. Minimizes the exam panel to provide more space for the project file. 

 Restart Project. Closes and reopens the current project file without saving your changes. 

 Submit Project. Saves your changes, submits the project file, and moves to the next project. 

 Calculator. A calculator is available in some exams. You are not required to use the calculator. 

 Restore. Restores the size and position of the project file and exam panel to the defaults.  Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 
 Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

 Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

 Mark for review. Flags the task to indicate that you want to return to it before you finish the exam.  Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Volunteer Analysis” chart sheet, drill down into the data to display the number of volunteer hours for each month. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Exhibit 7 (exhibit): 

Exhibit 8 (exhibit): 

Exhibit 9 (exhibit): 

Correct Answer: See explanation below. 

Section: National Parks 
Explanation 

Explanation/Reference: 

Explanation: 

If a chart has multiple fields in the Axis box, you set it to show levels and you see only one level at a time, starting with the top level. 

To enable drill-down, access the Design tab > Show Levels > Enable Drill Down One Level at a Time. if 

you double-click on one of the bars, you will see the bars for the underlying data. 

Reference: https://support.microsoft.com/en-us/office/add-drill-down-to-a-power-view-chart-or-matrix-d67c5026-62f7-4766-9b22-3a8448c13ecd 

QUESTION 5 
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SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 

1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

 To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

 To change the height of the exam panel, drag the split bar between the project file and the exam panel. 
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 To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
 To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands:  Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 
 Restart Project. Closes and reopens the current project file without saving your changes. 

 Submit Project. Saves your changes, submits the project file, and moves to the next project. 

 Calculator. A calculator is available in some exams. You are not required to use the calculator. 

 Restore. Restores the size and position of the project file and exam panel to the defaults.  Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

 Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

 Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

 Mark for review. Flags the task to indicate that you want to return to it before you finish the exam.  Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

You are creating a workbook for the regional meeting of Southridge Video. 

On the “Regional Sales” worksheet, in cells D4:F7, use the Fill Series feature to complete the sales projections using a linear growth rate of 500,000 per year. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Correct Answer: See explanation below. 

Section: Southridge Video 

Explanation 

Explanation/Reference: 

Explanation: 

1. Select all value cells for First-Year and Second-Year Sales. 

2. Drag the fill handle to the Fifth-Year Projections column. 

Reference: 
https://support.microsoft.com/en-us/office/project-values-in-a-series-5311f5cf-149e-4d06-81dd-5aaad87e5400 
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QUESTION 6 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 

1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 
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 To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

 To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

 To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 

 To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands:  Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

 Restart Project. Closes and reopens the current project file without saving your changes. 

 Submit Project. Saves your changes, submits the project file, and moves to the next project. 

 Calculator. A calculator is available in some exams. You are not required to use the calculator. 

 Restore. Restores the size and position of the project file and exam panel to the defaults.  Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

 Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

 Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

 Mark for review. Flags the task to indicate that you want to return to it before you finish the exam.  Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Employees” worksheet, in cell C4, enter a formula that returns the office phone number from the “Contact_Information” cell range using an exact match for the “Region” in column B. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Correct Answer: See explanation below. 

Section: Southridge Video 

Explanation 

Explanation/Reference: 

Explanation: 

In cell C4, type =M4 and press Enter. 

QUESTION 7 

SIMULATION 
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Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 

1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

 To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

 To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

 To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 

 To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands:  Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 
 Restart Project. Closes and reopens the current project file without saving your changes. 

 Submit Project. Saves your changes, submits the project file, and moves to the next project. 

 Calculator. A calculator is available in some exams. You are not required to use the calculator. 

 Restore. Restores the size and position of the project file and exam panel to the defaults.  Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 
 Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

 Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

 Mark for review. Flags the task to indicate that you want to return to it before you finish the exam.  Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

From the “Employees” worksheet, create a macro named “Header”. Store the macro in the current workbook. Configure the macro to insert the “Sheet Name” in the left header cell of the active page and the “Page Number” in the right header 

cell. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Correct Answer: See explanation below. 

Section: Southridge Video 

Explanation 

Explanation/Reference: 

Explanation: 

The Developer tab isn't displayed by default, but you can add it to the ribbon. 

On the File tab, go to Options > Customize Ribbon. 

Under Customize the Ribbon and under Main Tabs, select the Developer check box. 

Record a macro 

1. In the Code group on the Developer tab, click Record Macro. 

2. Optionally, enter a name for the macro in the Macro name box and a description in the Description box, and then click OK to start recording. 
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3. Select Page layout from the Ribbon and expand Page Setup. 

4. Select the Header/Footer tab and click Custom Header. 

5. In the Left section, click the Insert Sheet Name button. 

6. In the Right section, click the Insert Page Number button. 

7. Click OK. Then click OK again. 

8. On the Developer tab, click Stop Recording. 

 

9. On the Developer tab, click Macros to view the available Macros. 

10. Select the Macro and click Run. 

Reference: https://support.microsoft.com/en-us/office/show-the-developer-tab-e1192344-5e56-4d45-931b-

e5fd9bea2d45 https://support.microsoft.com/en-us/office/quick-start-create-a-macro-741130ca-080d-49f5-9471-

1e5fb3d581a8 

QUESTION 8 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 
 To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

 To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

 To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 

 To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands:  Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

 Restart Project. Closes and reopens the current project file without saving your changes. 

 Submit Project. Saves your changes, submits the project file, and moves to the next project. 

 Calculator. A calculator is available in some exams. You are not required to use the calculator. 

 Restore. Restores the size and position of the project file and exam panel to the defaults.  Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 
 Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

 Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

 Mark for review. Flags the task to indicate that you want to return to it before you finish the exam.  Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Plan Analysis” worksheet, modify the PivotTable to group the data by the values in the “Full Package Price” column. Group the values in steps of 100 beginning at 0 and ending at 200. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Correct Answer: See explanation below. 

Section: Southridge Video 
Explanation 

Explanation/Reference: 

Explanation: 

In the PivotTable, right-click a value and select Group. 

In the Grouping box, select Starting at and Ending at checkboxes, and edit the values if needed. (0 and 200 respectively) Under 

By, enter a number that specifies the interval for each group. (100) 

Select OK. 

Reference: https://support.microsoft.com/en-us/office/group-or-ungroup-data-in-a-pivottable-c9d1ddd0-6580-47d1-82bc-c84a5a340725#:~:text=In%20the%20PivotTable%2C%20right%2Dclick,edit%20the%20values%20if%20needed. 

QUESTION 9 
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SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 

1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 
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To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 

To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Popular Videos” worksheet, for cells B4:C17, create a conditional formatting rule that displays the five lowest values in bold Dark Red font. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Correct Answer: See explanation below. 

Section: Southridge Video 

Explanation 

Explanation/Reference: 

Explanation: 

Select the entire dataset. 

Go to Home –> Conditional Formatting –> Top/Bottom Rules –> Top 10 Items (or %) / Bottom 10 Items (or %). 

Select Bottom 10 items and a dialogue box will open. Change the number from 10 to 5 using the down arrow. 

Specify the format to be applied to the cells that meet the condition by using the drop-down on the right and selecting the Custom Format option. 
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In the dialog box that appears, select Bold from under Font style, then click the drop down arrow under Color and select Dark Red from the Standard colors. Click 

OK. 

Reference: https://trumpexcel.com/excel-conditional-formatting/ 

QUESTION 10 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks.  
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 
as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

You work for Lucerne Publishing. You are compiling sales and royalty data for authors the company represents. 

Configure Excel to disable all macros in the workbook without notification. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Correct Answer: See explanation below. 

Section: Lucerne Publishing 
Explanation 

Explanation/Reference: 

Explanation: 

Click the File tab. 

Click Options. 

Click Trust Center, and then click Trust Center Settings. 

In the Trust Center, click Macro Settings. 

Select the Disable all macros without notification option. Click 

OK. 
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Reference: https://support.microsoft.com/en-us/office/enable-or-disable-macros-in-office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6 
QUESTION 11 SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 

1. Project file 

2. Split bar 

3. Exam panel 
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You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 

To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “New Titles” worksheet, for cells E4:E24, create and apply a custom number format that displays the dates in the format “2020 January 01”. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Correct Answer: See explanation below. 

Section: Lucerne Publishing 
Explanation 

Explanation/Reference: 

Explanation: 

1. Select the cells you want to format. 

2. Press CTRL+1. 
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3. In the Format Cells box, click the Number tab. 

4. In the Category list, click Date, and then choose a date format you want in Type. You can adjust this format in the last step below. 

 

5. Go back to the Category list, and choose Custom. Under Type, you’ll see the format code for the date format you chose in the previous step. The built-in date format can’t be changed, so don’t worry about messing it up. The changes you 

make will only apply to the custom format you’re creating. 

6. In the Type box, make the changes you want using code from the table below. In our case, yyyy mmmm dd. 
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7. Click OK. 

Reference: https://support.microsoft.com/en-us/office/format-a-date-the-way-you-want-8e10019e-d5d8-47a1-ba95-
db95123d273e 

QUESTION 12 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 
as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Royalties” worksheet, the existing formula in the “Royalty Due” column calculates the royalties due to each author. On cell F4, modify the existing formula to return the amount of royalties due to the author only if the amount is greater 

than $25, and otherwise returns 0. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Correct Answer: See explanation below. 

Section: Lucerne Publishing 

Explanation 

Explanation/Reference: 

Explanation: 

You need to added reference an IF function to the current formula. 

The modified formula should resemble the following: =IF(currentformula>25,currentformula,0) 

Reference: 

https://support.microsoft.com/en-us/office/use-nested-functions-in-a-formula-9d7c966d-6030-4cd6-a052-478d7d844166?ui=en-us&rs=en-us&ad=us 

QUESTION 13 

SIMULATION 
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Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 

1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 
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To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 
Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 
Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Sales Analysis” worksheet, insert a slicer that allows users to filter the PivotTable by “Category”. Then use the slicer to display only “Psychology” books. 

The slicer size and position do not matter. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Correct Answer: See explanation below. 

Section: Lucerne Publishing 

Explanation 

Explanation/Reference: 

Explanation: 

1. Click anywhere in the table or PivotTable. 
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2. On the Home tab, go to Insert > Slicer. 

3. In the Insert Slicers dialog box, select the check boxes for the fields you want to display, then select OK. 

4. A slicer will be created for every field that you selected. Clicking any of the slicer buttons will automatically apply that filter to the linked table or PivotTable. 

Reference: https://support.microsoft.com/en-us/office/use-slicers-to-filter-data-249f966b-a9d5-4b0f-b31a-12651785d29d#:~:text=On%20the%20Home%20tab%2C%20go,the%20linked%20table%20or%20PivotTable. 

QUESTION 14 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks.  
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 
Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 
as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Royalty Analysis” worksheet, add the “Title ID” field as a PivotChart filter. Apply the filter to the chart to display only results for title ID “CO20”. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Correct Answer: See explanation below. 

Section: Lucerne Publishing 

Explanation 

Explanation/Reference: 

Explanation: 

In the PivotTable Field list, click on the field that you want to use as a Report Filter. 

Drag the field into the Filters box. 

On the worksheet, Excel adds the selected field to the top of the pivot table, with the item (All) showing. The values in the pivot table do not change. 

Click the Report Filter's drop-down arrow, to see a list of items in the field. Click on an item to select it, and click OK. 

Reference: https://contextures.com/Excel-Pivot-Table-Report-Filters.html 

QUESTION 15 

SIMULATION 
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Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 

1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 
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To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 

To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

This project has only one task. 

Configure Excel to automatically evaluate formulas only when a workbook is saved, and not each time data changes. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Correct Answer: See explanation below. 

Section: Ski Lessons 

Explanation 

Explanation/Reference: 

Explanation: 

1. Click “File” in the ribbon. 
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2. And then click “Options”. 

3. In the “Excel Options”, choose the “Formulas”. 

4. And then in the “Calculation Options”, check the option “Manual”. 

5. Check the Recalculate workbook before saving option. 
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6. And then click “OK” in the window. 

7. Next save the workbook. 

Reference: https://www.datanumen.com/blogs/prevent-excel-auto-calculating-updating-data-
workbook/ 

QUESTION 16 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 
To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 
Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 
as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

You are creating a workbook for VanArsdel Limited’s annual sales meeting. 

Require that users enter the password “P@ssword” before they can make structural changes to the workbook. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Correct Answer: See explanation below. 

Section: VanArsdel Limited 
Explanation 

Explanation/Reference: 

Explanation: 

1. Click Review > Protect Workbook. 
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2. Enter a password in the Password box. 

3. Click OK, and retype the password to confirm it, and then click OK. 

Reference: https://support.microsoft.com/en-us/office/protect-a-workbook-7e365a4d-3e89-4616-84ca-
1931257c1517 

QUESTION 17 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 
Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 
as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Sales Conference” worksheet, configure cells A4:A12 to allow only whole numbers from 1 to 9. Otherwise, display a Stop error with the title “Invalid” and the message “1 to 9”. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Correct Answer: See explanation below. 

Section: VanArsdel Limited 

Explanation 

Explanation/Reference: 

Explanation: 

1. Select the cell(s) you want to create a rule for. 

 

2. Select Data >Data Validation. 

3. On the Settings tab, under Allow, select an option: 
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 Whole Number - to restrict the cell to accept only whole numbers. 

 Decimal - to restrict the cell to accept only decimal numbers. 

 List - to pick data from the drop-down list. 

 Date - to restrict the cell to accept only date. 

 Time - to restrict the cell to accept only time. 

 Text Length - to restrict the length of the text. 

 Custom – for custom formula. 

4. Under Data, select a condition: between not between equal to not equal to greater than less than greater than or equal to less than or equal to 

5. On the Settings tab, under Allow, select an option: 

6. Set the other required values, based on what you chose for Allow and Data. For example, if you select between, then select the Minimum: and Maximum: values for the cell(s). 

7. Select the Ignore blank checkbox if you want to ignore blank spaces. 

8. If you want to add a Title and message for your rule, select the Input Message tab, and then type a title and input message. 

9. Select the Show input message when cell is selected checkbox to display the message when the user selects or hovers over the selected cell(s). 

10. Select OK.Now, if the user tries to enter a value that is not valid, a pop-up appears with the message, “This value doesn’t match the data validation restrictions for this cell.” 

Reference: https://support.microsoft.com/en-us/office/apply-data-validation-to-cells-29fecbcc-d1b9-42c1-9d76-eff3ce5f7249?ui=en-us&rs=en-
us&ad=us 

QUESTION 18 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 
To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 

To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 
Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 
as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Year-to-Date Sales” worksheet, in cells L5:L15, enter a formula that returns the average “Total Sales” for the region in cell J5 and the “Representative” in cell K5. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Correct Answer: See explanation below. 

Section: VanArsdel Limited 

Explanation 

Explanation/Reference: 

Explanation: 

Click in Cell L5, and select Formulas from the ribbon. 

Click on the arrow of the AutoSum button in the Function Library section, and select Average. Click 
on Cell H4, H5, H6, then press Enter.The formula should look like this:=AVERAGE(H4,H5,H6) 

Reference: https://support.microsoft.com/en-us/office/average-function-047bac88-d466-426c-a32b-8f33eb960cf6 

QUESTION 19 

SIMULATION 

Instructions 
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Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 

1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
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To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Sales Summary” worksheet, create one chart that displays each representative’s “Total Sales” as an Area chart and the “Grand Total Percentage” as a secondary axis Line chart. 

The chart size and position do not matter. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Correct Answer: See explanation below. 

Section: VanArsdel Limited 

Explanation 

Explanation/Reference: 

Explanation: 

1. Select the range. 

2. On the Insert tab, in the Charts group, click the Combo symbol. 
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3. Click Create Custom Combo Chart. 

 

The Insert Chart dialog box appears. 

4. For the Total Sales series, choose Area as the chart type. 

5. For the Grand Total Percentage series, choose Line as the chart type. 

6. Plot the Grand Total Percentage series on the secondary axis. 

7. Click OK. 

Reference: https://www.excel-easy.com/examples/combination-
chart.html 

QUESTION 20 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 
as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Regional Sales” worksheet, modify the PivotTable to display the “Territory” rows within each region. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Correct Answer: See explanation below. 

Section: VanArsdel Limited 

Explanation 

Explanation/Reference: 

Explanation: 

Click anywhere in the PivotTable to display the Field List. 

Check the box next to Territory, and it should be added to the Rows area by default. The 

PivotTable should now be displaying Territory rows within each region. 

Reference: https://support.microsoft.com/en-us/office/use-the-field-list-to-arrange-fields-in-a-pivottable-43980e05-a585-4fcd-bd91-
80160adfebec 

QUESTION 21 

SIMULATION 

Instructions 
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Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 

1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
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To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 

as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

You are creating a product workbook for Tailspin Toys. 

On the “Inventory” worksheet, use an Excel feature to remove the duplicate records from the “Products” cell range. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Correct Answer: See explanation below. 

Section: Tailspin Toys 

Explanation 

Explanation/Reference: 

Explanation: 

1. Select the range of cells that has duplicate values you want to remove. 
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2. Click Data > Remove Duplicates. 

3. Under Columns, check only the Products column. 

4. Click OK. 

Reference: https://support.microsoft.com/en-us/office/find-and-remove-duplicates-00e35bea-b46a-4d5d-b28e-66a552dc138d 

QUESTION 22 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks.  
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 
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4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 
as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Employees” worksheet, in cell F4, enter a formula that returns the employee’s bonus from the “Years of Service Bonus” table. 

Adjust the formula and then copy it to cells F5:F19. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Correct Answer: See explanation below. 

Section: Tailspin Toys 
Explanation 

Explanation/Reference: 

Explanation: 

Select cell F4. 

Enter the following formula:=INDEX($I$2:$I$7,MATCH(B4,$H$2:$H$7,1),1) Press 

Enter. 

Reference: https://trumpexcel.com/index-match/ 

QUESTION 23 

SIMULATION 
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Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks. 

 

1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 

To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 
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To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 
Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 
as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “Retail” worksheet, display arrows that indicate the cell values that are dependent on the value in C4. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Correct Answer: See explanation below. 

Section: Tailspin Toys 

Explanation 

Explanation/Reference: 

Explanation: 

Select the cell for which you want to identify the dependent cells. 

2. To display a tracer arrow to each cell that is dependent on the active cell, on the Formulas tab, in the Formula Auditing group, click Trace Dependents  

Blue arrows show cells with no errors. Red arrows show cells that cause errors. If the selected cell is referenced by a cell on another worksheet or workbook, a black arrow points from the selected cell to a worksheet icon  

The other workbook must be open before Excel can trace these dependencies. 
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Reference: https://support.microsoft.com/en-us/office/display-the-relationships-between-formulas-and-cells-a59bef2b-3701-46bf-8ff1-
d3518771d507 

QUESTION 24 

SIMULATION 

Instructions 

Exam Environment 

Exam Interface and Controls 

The exam panel provides access to the project task(s). Each project has an associated file in which you will perform the project tasks.  
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1. Project file 

2. Split bar 

3. Exam panel 

You can modify the exam interface to fit your needs in the following ways: 
To increase or decrease the exam panel font size, press Ctrl+Plus or Ctrl+Minus. 

To change the height of the exam panel, drag the split bar between the project file and the exam panel. 

To minimize the exam panel, click the Collapse Panel arrow  in the upper-left corner of the exam panel. The minimized exam panel displays the Expand Panel button, the project number and name, the remaining time, and the Restart 

Project and Submit Project buttons. To move between tasks, you must expand the exam panel. 
To restore the interface to the default appearance, click the Restore button near the upper-right corner of the exam panel. 

www.vceplus.com - Free Questions & Answers - Online Courses - Convert VCE to PDF - VCEplus.com



 

4. The Information bar at the top of the exam panel displays the current project and total number of projects, the remaining exam time, and the following commands: Collapse Panel. Minimizes the exam panel to provide more space for the 

project file. 

Restart Project. Closes and reopens the current project file without saving your changes. 

Submit Project. Saves your changes, submits the project file, and moves to the next project. 

Calculator. A calculator is available in some exams. You are not required to use the calculator. 

Restore. Restores the size and position of the project file and exam panel to the defaults. Help. 

Displays information about the exam interface. 

5. The Content area displays the task tabs and the current task description. 

6. The Navigation area at the bottom of the exam panel contains the following commands. 

Previous Task/Next Task. Saves your response and moves to the previous or next task in the current project. 

Leave feedback after exam. Flags the task to indicate that you want to leave feedback about it after the exam. 

Mark for review. Flags the task to indicate that you want to return to it before you finish the exam. Mark 
as complete. Flags the task to indicate that you feel you have completed the task. 

In projects that contain multiple tasks, you can switch between tasks by clicking the task tab, Next Task button, or Previous Task button. 

End of the instructions. 

On the “New Products” worksheet, create a Histogram chart that shows the “Retail Price” of the products in bins with widths of $10. 

The chart size and position do not matter. 

Exhibit 1 (exhibit): 

Exhibit 2 (exhibit): 

Exhibit 3 (exhibit): 

Exhibit 4 (exhibit): 

Exhibit 5 (exhibit): 

Exhibit 6 (exhibit): 

Correct Answer: See explanation below. 

Section: Tailspin Toys 
Explanation 

Explanation/Reference: 

Explanation: 

1. Select your data. 

2. Click Insert > Insert Statistic Chart > Histogram. 

3. Right-click the horizontal axis of the chart, click Format Axis, and then click Axis Options. 
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4. Use the information in the following table to decide which options you want to set in the Format Axis task pane. 
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Reference: 

https://support.microsoft.com/en-us/office/create-a-histogram-85680173-064b-4024-b39d-80f17ff2f4e8 
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